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General Information:

VCalc, (for "Vehicle Calculator"), stores, calculates, and analyzes the cost and efficiency 
of your vehicles (including cars, aircraft, boats,...).      Carefully designed and 
programmed to be simple in use, yet sophisticated in features.

Hansen Software
155 E. "C" St., Suite "D"

Upland, CA    91786

E-Mail: 74721.3027@CompuServe.COM

Member of The Association of Shareware Professionals (ASP)

Copyright Ó 1995, 1996 Hansen Software.    All rights reserved.

Version Changes..
VCalc3...
Credits...



 Selecting, Adding, & Deleting Vehicles  :  
To add a new vehicle to the vehicle list, open the new vehicle form (from the vehicle list
form), then fill in all of the blanks on the form.    The vehicle's license number will 
become part of the filename of the files used to store its data.    If your vehicle's license 
number is longer than seven digits, then merely enter the first seven digits of it.    For the 
"Type" of vehicle, "Mileage Based" refers to vehicles like cars, trucks, and busses.    
"Hourly Based" refers to vehicles like boats, aircraft, and snowmobiles (which have hour 
meters, instead of odometers).    Press "Enter New Vehicle" to complete the new vehicle 
addition.

To select a vehicle which has already been added to the vehicle list, open up the 
vehicle list form, and then either double-click on the vehicle of choice, or else highlight 
the vehicle to select (single-click with the mouse button), then press "Select".    The 
vehicle should then be displayed in the line at the top of the form, showing it as the 
current vehicle.

To remove a vehicle from the vehicle list, open up the vehicle list form, highlight the 
vehicle to remove, then press "Remove".    The vehicle should then be removed from the 
list, though any associated data files will still exist on the hard disk.    To delete the data 
files, open up File Manager (or any other method of managing files), and delete all of the 
files which begin with the deleted vehicle's license plate.    At most, there will be seven 
files, one ending in "1DT", one in "2DT", one in "3DT".... up to "7DT".    For example, if 
the license plate were "LPLATE1", then one of the data files would be named 
"LPLATE1.1DT".

To adjust the column widths in the vehicle list form:    With some screen resolutions, 
the column widths of the vehicle list form may need to be adjusted to be in alignment 
with the titles.    To do this, press Ctrl, then move the mouse pointer over the column line 
to be moved.    The mouse pointer should then change to a double arrow.    While still 
pressing Ctrl, Press the left mouse button to "grab" the line, drag it to where it should be, 
then release both the mouse button and Ctrl.    Press the "Select" button to save the 
column positions as the default.

To import a VCalc V1.1 vehicle list, see the instructions under Advanced Setup



VCalc Setup:
This form sets what will be displayed each time that VCalc starts up.

If    "Last `Save Data'" is chosen for the default category, then VCalc will save the current 
category as the default, each time that "Save Data" is pressed.

Changing the "Category Titles" will affect what is displayed whenever a category is 
referred to (the buttons, the top of the main window, the graphs, the statistics,...).    

When "Save" is pressed, not only are the current settings saved as the default, but also the
"state" of VCalc's main window ("maximized" or "normal").



VCalc Advanced Setup:
These settings have been called "Advanced", because careless settings can cause 
problems with VCalc.    

Maximum number of rows in each table:
Before registration, VCalc limits data input to 7 rows.    After registration, the 
number may be anywhere from 7 to 2000.    It may be desirable to set the number 
to less than 2000, because unless there are nearly 2000 rows of data entered, then 
the vertical scroll bar will operate more efficiently.    But be careful when setting 
this, because if this is set to a number which is less than the number of rows of 
data which have already been entered, then the excess data will be lost.

Printer and screen fonts:
Experimentation is the best way to find the best results.    Some settings will 
produce a real mess on the screen or printer, so, if it looks hopeless, then just 
press the "Restore `Factory' Defaults" button, to bring back the settings which 
seem to work well on most computer systems.

Importing V1.1 Files:
To import a V1.1 vehicle list, merely press the "Vehicle List" button.    This will 
search the current working directory for the file "VCALC1VS.DAT" (where V1.1 
vehicle lists are stored), load it into memory, modify it to the version 2 format, 
and then save it to disk again, as "VCALC2VS.DAT", overwriting any existing 
copy of that file.    The same process may be done for column widths.



Adjusting Column Widths  :  
To Adjust Column Widths:

1)    Press and hold the Ctrl key.
2)    Move the mouse cursor over the vertical line to move.    The cursor will 
change to a double arrow.
3)    While still holding the Ctrl key, press and hold the left mouse button.
4)    Move the line.
5)    Release the mouse button and the Ctrl key.
6)    To save the column configuration as the default layout, open the Setup form 
("File > Setup"), and press "Save Column Widths".



Entering Data into the Tables:
To automatically enter the present date into a date column, select a date cell, then 
press "X".

Gasoline/Fuel:    Fill in the left six columns, and the right three columns are calculated 
by VCalc.    To automatically copy the ending mileage/hour of the previous line into the 
starting mileage/hour of the current line, press "X" after selecting the "Start Mileage" cell
to receive the number.    

Maintenance/Repairs:    One thing worth noting here:    Some expenses, like a service 
contract, which basically pays for all repairs over a long period, should be entered into 
the maintenance table as a monthly expense, rather than as one large, one-time expense.    
Doing this will produce more meaningful statistics and graphs.    "Future" expenses (like 
insurance, when it's paid six months to a year in advance) may be entered freely, because 
the statistics and graphs allow the user to restrict the data used according to mileage and 
date.

Other expenses (insurance, licensing, purchase payments, wash jobs,...):    As was 
described for maintenance, all of these expenses should be divided up into "per month" 
expenses, in order to produce more meaningful statistics and graphs.    To help with this 
task, a feature called "Table Filler" has been included, which basically takes an expense, 
divides it up into any number of months, and then enters the monthly expenses into the 
table.



VCalc3  :  
Some of the features being considered for VCalc3:

*    A "Table Filler" for depreciation
*    A version for OS/2
*    A version for Windows `95 
*    "Search", to find a particular vehicle (when a long list of vehicles has been entered)
*    Foreign language version(s)
*    User definable category type (for more than one "gasoline" or "maintenance" type of 
table)
*    User definable category quantity
*    A category for mileage logging (like business/personal miles).
*    The separation of maintenance from repairs.
*    A more integrated graphing form.
*    Improved print interface
*    Increased speed and decreased size
*    More stats and graphs



Credits:
Special thanks to James Sylvester, masters in computer programming, for his testing and 
evaluating of VCalc.



Version 2 Changes:
Version 2.X adds several new features not found in version 1.X:

1)    Seven categories, instead of six.
2)    Category titles may be modified by the user.
3)    Can accommodate vehicles like boats, aircraft, snowmobiles,..., which use 
hours to track their operating duration, rather than miles.
4)    When entering information into the gasoline table, the "start mileage" (or start
hours) may be automatically transferred in from the previous "end mileage", 
simply by pressing "X".
5)    The present date (as returned by the computer's internal clock) may be 
automatically inserted into the date cell, simply by pressing "X".
6)    Graphing module includes one more graph, "Maintenance Timeline", to help 
visualize when a vehicle is starting to fall apart.
7)    Many minor features and refinements.

Version 2.X removes one feature from Version 1.X:
The size and location of VCalc's main window is no longer saved, though its 
"state" (maximized or "normal") still is.

Version 2.7:
Solves a problem with the graph of "all seven".    In previous versions, the first 
year of the series was excluded from the graph.

V1.1 Registered Users may upgrade to V2.x at a reduced rate.



 Table Sorter:
The Table Sorter reorganizes the currently selected table, based on the criteria which is 
chosen.    

Sorting by Text Columns:
While this may seem ridiculous at first, it may be useful, depending on how it's 
used.    For example, while in the maintenance section, if the category was sorted 
by "Mechanic", then all services done by a particular mechanic/service 
shop/dealer/... would be grouped together.    Another example would be if "heavy 
load" were entered into the notes column of the gasoline/fuel category, each time 
that a heavy load was carried.    Sorting would then help in determining the effect 
that a heavy load has on gasoline/fuel usage.



 Statistics:
At the top of the Stats form is the start date, end date, start mileage (or hours), and end 
mileage (or hours).    The start date and start mileage reflect what was entered when the 
vehicle was added to the vehicle list.    The end date reflects the current date, as returned 
from the computer's internal clock.    The end mileage reflects the highest mileage entered
into the gasoline/fuel table.    In some cases, it may be necessary to adjust these values, in 
order to produce more accurate statistics.    In other cases, it may be desirable to adjust 
these values, in order to view the statistics from a different perspective.    In any case, 
press "Recalculate" after adjusting them to reflect the changes in the stats.

Along the left side of two of the statistics areas are a column of check boxes.    "Un-
checking" one of these will eliminate that row from the sum-total at the bottom.



 Graphs:
When "Graphs" is selected from the "Analyze" menu, the VCalc graphing program is 
started up.    This is actually a complete, stand-alone program, though it is designed to 
function seamlessly with VCalc.    It was written as a separate program in order to 
improve the speed of VCalc.    When started up from VCalc, the current vehicle, screen 
color, and category titles are automatically transferred.

As with most all graphs, they aren't very useful until a significant amount of data has 
been entered.    After a few years of entering data into VCalc, these graphs will become 
more and more informative about the vehicle's cost and efficiency.

At the top of the Graph Selection form is the Starting Date, Ending Date, Starting 
Mileage (or hours), and Ending Mileage (or hours), of the vehicle.    These may be 
adjusted as necessary or desired.    See Statistics for more information on this.

Note:    When printing out the graphs, don't choose color printing unless a color printer is 
selected (and is set for color printing), or else whole lot of black ink or toner will be 
wasted.



Trouble-Shooting & Technical Support  :  
If you experience a problem with VCalc, first try to determine that the problem is actually
within VCalc.    Basically, if a similar problem happens with other programs, then the 
problem probably isn't within VCalc.

Basically, there are three "levels" of errors which can occur when using VCalc:
1)    A user error, like entering "45/32/95" into a date column.    VCalc displays a 
message describing the problem.
2)    An error showing that something has gone wrong with the normal flow of the 
program.    This can be caused by a variety of factors, like a hardware problem, a 
corrupted file, or a "bug" within VCalc.    With these types of errors, VCalc should
display a detailed error message, including an error code, describing what went 
wrong.    If one occurs, take note of the entire message.
3)    An error generated by the Windows operating system.    This is the most 
serious type of error, one which has somehow escaped VCalc's error handling 
techniques.

If a "level 2" or "level 3" error occurs, and you can't fix the problem, then technical 
support will be needed from Hansen Software.    Hansen Software's support policy is:

1)    For unregistered users (during the trial period), support is supplied, though 
there may be a delay, as registered users are helped first.
2)    After registration, support is supplied for a minimum of six months from the 
date of registration.    After six months, support will be supplied at the discretion 
of Hansen Software.    Support is supplied via E-Mail, or USPS mail.    When 
writing, please include:

A)    Your name, address, and password, as it's stated on your registration 
form.
B)    Error messages which are displayed.
C)    (optional) Other information which may be helpful in determining the
problem:

a)    The situation(s) under which the problem occurs.
b)    Computer system description.

3)    "Bugs", if any are found, will be fixed promptly, and will be distributed to 
registered users either by the mailing of floppy disks, or by the uploading and 
downloading through the following on-line services:

* CompuServe (GO > WINPROD (Windows Shareware Productivity 
Forum).    Search the file area using filename "VCalc*.*").
* Exec-PC BBS (414-789-4360)
* Channel 1 BBS (617-354-8873)
* The Nashville Exchange (615-383-0727)

Hansen Software
155 E. "C" St., Suite "D"

Upland, CA    91786

E-Mail: 74721.3027@CompuServe.COM





Registration  :  
Before registration, VCalc limits data entry to 7 rows.    After registration, the limit is 
2000 rows (which, unless vehicles start lasting a lot longer than they do now, then 2000 
should be more than enough).    

To register VCalc:
1)    Open up VCalc's registration form (File > Registration).

2)    Fill in the "Registrant Information" section.    In the "name" section, please 
use only personal names (no company names).

3)    Print out the information.    If a printer isn't available, then merely write down 
the "Registrant Information", including the "Copy Number", on an 8-1/2" x 11" 
sheet of paper.

4)    Mail the printout, along with a check for the requested fee, to Hansen 
Software.    V1.1 Registered users may upgrade at a reduced rate.

5)    Within two weeks, the password will be delivered which will provide the full, 
unlimited use of this program, along with full technical support.    You also will 
receive thanks for your patronage, and thanks for being a productive part of the 
shareware market.

Hansen Software
155 E. "C" St., Suite "D"

Upland, CA    91786

E-Mail: 74721.3027@CompuServe.COM



Distribution  :  
If    VCalc is distributed to others, and it's hoped that it will be, then please follow these 
directions:

1)    The best and easiest way, is to distribute VCalc in the original "package" that 
it was received in (floppy disk, "ZIP" file,...), assuming that it was received it in 
its proper form.

2)    If the original "package" isn't available, then first "un-register" the copy that 
will be distributed.    The way to do this is to not distribute the file, 
"VCALC2RF.DAT" (The file which contains all of the registration information).

3)    Please distribute these files only:
VCALC27.EXE    (VCalc program)
VCALC27.HLP    (Help file for VCalc)
VCALCG27.EXE    (VCalc's graphing program)
GSW.EXE    (A background program which handles the details of 
graphing)
THREED.VBX    (A companion file)
TRUEGRID.VBX    (A companion file)
CMDIALOG.VBX    (A companion file)
GRAPH.VBX (A companion file to GSW.EXE)
MSAFINX.DLL    (A companion file)
COMMDLG.DLL    (A companion file)
GSWDLL.DLL (A companion file to GSW.EXE)
INSTALLV.WRI    (A "Write" file to aid in installation)
FILE_ID.DIZ (BBS program description)

4)    While the file "VBRUN300.DLL" is required by VCalc, it does not need to 
be included when uploading to BBSs, as this file is usually available separately on
most systems.    When distributing VCalc using a floppy disk, you may want to 
include this file, just in case the person receiving it doesn't already have it.

Thank you for distributing VCalc.



VCalc V1.1 Registered Users:
V1.1 registered users may upgrade to V2.X for only $5.00 (the price difference between 
the two versions).    To do so, register V2.X as normal, but write your V1.1 registrant 
information and V1.1 password on the page, and include a check for only $5.00.



 The Association of Shareware Professionals

The Association of Shareware Professionals (ASP) is an organization of shareware 
professionals, dedicated to maintaining high standards of quality and service within the 
shareware market.    To become a member, both authors and their programs must meet 
many standards of quality and service.    The following statement is provided to you, the 
user of the program, from the ASP:

"Hansen Software is a member of the Association of Shareware Professionals (ASP).    
ASP wants to make sure that the shareware principle works for you.    If you are unable to
resolve a shareware-related problem with an ASP member by contacting the member 
directly, ASP may be able to help.    The ASP Ombudsman can help you resolve a dispute 
or problem with an ASP member, but does not provide technical support for members' 
products.    Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI    
49442-9427 USA, FAX 616-788-2765 or send a CompuServe message via CompuServe 
Mail to ASP Ombudsman 70007,3536"



Removal
To remove VCalc from your computer system:

1)    Delete all of the files in the VCalc directory.    For a list of the files, see 
"Distribution".
2)    If you installed "VBRUN300.DLL" into your Windows "system" directory 
especially for VCalc, then it's probably best just to leave it there, because there are
many other shareware programs which utilize this file as well.    If the file already 
existed in that directory before you loaded VCalc, then do not delete it, because 
it's possible that the file is currently in use by some other program.
3)    Delete the directory which was created for VCalc.
4)    Remove the icon which was created for VCalc.
5)    That should do it.




